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AVERTISSEMENTS 
 
À lire avant utilisation 

 

Ce manuel doit être lu attentivement par toutes les personnes qui sont responsables ou 
auront la responsabilité de l’utilisation, la maintenance ou l’entretien de ce produit. 
Ce produit fonctionnera comme prévu uniquement s’il est utilisé, entretenu et réparé 
conformément aux instructions du fabricant  

 

Enregistrement de la garantie 
Enregistrez votre garantie en ligne en accédant au site : 

 

 http://www.raesystems.com/support/product-registration 

 

Vous avez ainsi l’assurance que le logiciel ProRAE Studio II est enregistré et que nous 
pouvons vous informer des mises à jour importantes.
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1. Renseignements généraux 
Le logiciel ProRAE Studio II permet de télécharger les journaux de données et les paramètres 
de configuration des instruments RAE Systems sur un ordinateur et de charger des 
configurations à partir d’un ordinateur.  
 

Le logiciel ProRAE Studio II prend en charge six instruments RAE Systems. Ceux-ci doivent 
déjà contenir les versions de microprogramme répertoriées ci-dessous (ou une version 
ultérieure) : 
 

Nom de l’instrument Version de microprogramme  
 minimale requise 
ppbRAE 3000 1.03B 
MiniRAE 3000 1.05A 
MiniRAE Lite 1.05A 
MiniRAE Lite (ATEX) 1.05A 
UltraRAE 3000 1.05 
QRAE II 2.00 
ToxiRAE Pro PID 1.00 
ToxiRAE Pro LEL 1.10 
ToxiRAE Pro 1.10 
MiniRAE Lite (Fumigation) 1.07 
GammaRAE II R 3.60 
NeutronRAE II (PRM-3020)  V2.00 
NeutronRAE II (PRM-3021)  V3.01 
MultiRAE Lite (PGM-6208)  V1.00 
MultiRAE Lite (PGM-6208D)  V1.00 
MultiRAE (PGM-6220)  V1.00 
MultiRAE (PGM-6226)  V1.00 
MultiRAE (PGM-6228)  V1.00 
MultiRAE Pro (PGM-6248)  V1.00 
Contrôleur AutoRAE 2 (DKS-6000) V1.00 
Base MultiRAE (Pumped) (DKS-6001) V1.00 
 

 
Le logiciel ProRAE Studio II communique avec ces instruments via le port série, une carte SD 
et le contrôleur AutoRAE 2 (en fonction des instruments connectés) lors de leur configuration 
ou du téléchargement de leur journal de données. Consultez le manuel du produit pour plus 
de détails sur la connexion avec un ordinateur et sur les consignes de sécurité. 
 

Cette version du logiciel permet de :  
 

• télécharger des journaux de données  
• télécharger des paramètres de configuration  
• modifier et charger de nouveaux paramètres de configuration  
• charger un microprogramme 
• télécharger des rapports 
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2. Prérequis matériels et logiciels 

2.1. Matériel 
 

Processeur : processeur cadencé à 1 GHz 
Moniteur : moniteur VGA avec une résolution de 1 024 x 768 minimum 
Mémoire (RAM) : 256 Mo 
Espace disque : 10 Mo d’espace libre 

2.2. Logiciel 
 

Système d’exploitation : Windows XP, Windows Vista ou Windows 7 
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3. Installation de ProRAE Studio II 
 
1. Chargez le logiciel ProRAE Studio II à partir du CD-ROM ou double-cliquez sur 

l’icône si le logiciel a été téléchargé depuis Internet. (Si aucune fenêtre d’installation 
ne s’affiche automatiquement, ouvrez le dossier et double-cliquez sur le fichier 
« Autorun.exe ».) 
 

  
 
Remarque : votre ordinateur peut nécessiter un pilote USB pour se connecter à certains 
moniteurs. Cliquez sur Adapter Drivers (Pilotes de carte) et suivez les instructions d’installation. 
 

  
 

Remarque : pour les modèles d’instruments GammaRAE II R et NeutronRAE II, 
l’ordinateur doit être équipé d’un adaptateur Bluetooth et le pilote approprié doit être 
installé pour l’adaptateur. Il est recommandé d’utiliser un adaptateur de la marque 
IOGEAR. 
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2. Lisez les recommandations avant de continuer.  Pour assurer une installation réussie, 
il est conseillé de quitter tous les autres programmes en cours d’exécution. Cliquez 
ensuite sur « Next » (Suivant). 

 

  
 

3. Sélectionnez la langue dans laquelle vous souhaitez que le programme s’exécute. 
Cliquez ensuite sur « Next » (Suivant). 
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4. Sélectionnez le dossier d’installation du logiciel. Acceptez le dossier par défaut 
en cliquant sur « Next » (Suivant) ou choisissez un nouveau dossier en cliquant sur 
le bouton « Change… » (Modifier...), qui vous permet de sélectionner un autre 
emplacement. Une fois terminé, cliquez sur le bouton « Next » (Suivant). 
 

  
 

5. Sélectionnez le dossier d’installation du raccourci. Cliquez ensuite sur « Next » 
(Suivant). 
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6. Le logiciel est prêt à être installé. Cliquez sur « Next » (Suivant). pour commencer. 
 

  
 
 

7. Les barres de progression indiquent que le logiciel est en cours d’installation : 
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8. Une fois le logiciel ProRAE Studio II correctement installé, la fenêtre ci-dessous 
s’affiche : 
 

  
 
Remarque : si aucun pilote approprié n’est installé ou si les pilotes installés sur 
l’ordinateur sont obsolètes, une fenêtre contextuelle apparaît et vous invite à installer 
le(s) pilote(s) approprié(s). 
 

9. Cliquez sur « Finish » (Terminer). La fenêtre se ferme. Le logiciel est désormais prêt 
à être utilisé. 
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4. Connexion de l’instrument à l’ordinateur 
 
L’instrument doit être connecté à l’ordinateur, sous tension et en mode de communication 
pour transmettre et recevoir des données via ProRAE Studio II.  
 
Remarque : l’instrument QRAE II n’a pas besoin d’être mis sous tension. Assurez-vous 
qu’il est posé sur sa base et que celle-ci est connectée à l’ordinateur. Assurez-vous, en outre, 
que le chargeur est branché. 
 
La méthode de connexion à l’ordinateur varie suivant l’instrument utilisé. Suivez les 
instructions du guide de l’utilisateur livré avec l’instrument, afin de vous assurer d’utiliser 
le câble et la méthode de communication appropriés. Vous devez également vous 
assurer que la batterie de l’instrument est chargée. 
 

4.1. Connexion des instruments RAE Systems via  
         l’adaptateur USB 
 
Pour la famille MiniRAE 3000, ppbRAE 3000, MiniRAE Lite, UltraRAE 3000, ToxiRAE Pro 
ou la nouvelle famille MultiRAE, le contrôleur AutoRAE 2 ou la base AutoRAE 2 
 
Assurez-vous que le pilote de port COM virtuel CP210x est correctement installé (ce pilote 
se trouve sur le CD-ROM d’installation). Placez l’instrument sur la base et connectez celle-
ci au port USB de l’ordinateur. Dans le Device Manager (Gestionnaire de périphériques), 
recherchez le port COM virtuel correspondant. Allumez l’instrument et placez-le en mode 
de communication PC. (Le guide de l’utilisateur décrit cette opération). En cas d’utilisation 
du contrôleur AutoRAE 2, cette opération est exécutée automatiquement. 
 

4.2. Produits émettant des radiations  
         (GammaRAE II R et NeutronRAE II) 
 
Vérifiez que le pilote de l’adaptateur Bluetooth est correctement installé et qu’un port 
COM virtuel est créé pour la communication. 
 

4.3. Contrôleur AutoRAE 2 
 
Reportez-vous à la page 36 pour plus de détails sur l’établissement des connexions et le 
transfert des données à l’aide d’un contrôleur AutoRAE 2 via la technologie USB. 
 

4.4. Carte SD (Contrôleur AutoRAE 2) 
 
Reportez-vous à la page 36 pour plus de détails sur l’établissement des connexions et le 
transfert des données à l’aide d’un contrôleur AutoRAE 2 via une carte SD. La carte SD 
doit être extraite du contrôleur AutoRAE 2 et connectée à un ordinateur personnel, puis 
ouverte sous ProRAE Studio II. 



Guide de l’utilisateur ProRAE Studio II version 1.5 

 Page 11  

5. Configuration de port 
 
Outre la connexion de l’instrument et de l’ordinateur, le port doit également être configuré. 
Les étapes suivantes permettent de sélectionner le numéro de port correct. 
 
1. Branchez l’instrument sur l’ordinateur à l’aide d’un câble USB (un adaptateur peut 

être nécessaire). 
 
2. Configurez le port de l’ordinateur. Suivez le chemin suivant : 

 
   Start (Démarrer) >> Settings (Paramètres) >> Control Panel (Panneau de configuration)  
   >> System (Système). 

 
3. La boîte de dialogue « System Properties » (Propriétés système) s’affiche. Cliquez sur 

« Hardware  (Matériel). 
 

 
 

4. Cliquez sur « Device Manager  (Gestionnaire de périphériques). Une liste des 
périphériques installés sur ou connectés à votre ordinateur apparaît. Parcourez la liste 
vers le bas jusqu’à l’élément « Ports ».  
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5. Ouvrez Ports (cliquez sur le symbole « + » en regard de celui-ci). Le nom du pilote 
et son numéro de port apparaissent (par exemple, COM6). Notez le numéro de port. 
Ce dernier sera peut-être demandé au démarrage de ProRAE Studio II. 

 

 
 

Remarque : la connexion au port USB est décrite sous « Universal Serial Bus 
Controller (Contrôleur de bus USB), figurant sous l’élément « Ports (COM & LPT) » 
dans la liste. Elle ne nécessite aucune configuration mais, le cas échéant, vérifiez 
que cette connexion fonctionne correctement. 
 

 
 

 

6. Fermez le Device Manager (Gestionnaire de périphériques) et les System Properties 
(Propriétés système). 
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6.  Démarrage de ProRAE Studio II 

6.1. Fonction « Dump » (image mémoire) de ProRAE Studio II 
 

IMPORTANT! 
 
Par défaut, ProRAE Studio II offre une fonction « image mémoire » qui génère un fichier 
texte nommé « dump.txt », qu’il place dans le dossier ProRAE Studio II du dossier 
Program Files sur l’ordinateur (par exemple, C:\Program Files\RAE Systems Inc\ProRAE 
Studio II). Ce fichier est très utile en cas de défaillance du logiciel et pour obtenir une 
assistance technique. Si vous souhaitez envoyer ce fichier, ne redémarrez pas ProRAE 
Studio II avant d’en avoir fait une copie, sinon le fichier sera tronqué lors du démarrage 
de ProRAE Studio II. 
 
Pour accéder à ce fichier, cliquez avec le bouton droit de la souris sur le raccourci de 
ProRAE Studio II. La fenêtre suivante s’affiche : 
 

      
 
Si vous choisissez d’ignorer la fonction « image mémoire », vous pouvez la désactiver 
en ajoutant le suffixe « .nodump » au raccourci du programme. 
 
Remarque : le chemin peut être différent de celui illustré dans cet exemple, en fonction 
de l’emplacement de l’installation. 
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7. Démarrage de ProRAE Studio II depuis le bureau 
 
Une fois l’ordinateur et le moniteur reliés par un câble, vous êtes prêt à établir la 
communication. 
 
1. Suivez les instructions du Guide de l’utilisateur du moniteur. Ceci inclut de mettre sous 

tension le moniteur et de vérifier qu’il est connecté directement par câble ou via une 
base reliée à l’ordinateur par un câble. Certains moniteurs détectent automatiquement 
l’ordinateur et le logiciel et basculent en mode de communication. D’autres, comme 
le modèle ppbRAE 3000, par exemple, nécessitent que vous activiez le mode de 
communication PC. 

2. Double-cliquez sur l’icône ProRAE Studio II sur le bureau pour démarrer le programme : 
 

  
 

3. Le programme démarre et une boîte de dialogue de connexion s’affiche : 
 

 
 
Remarque : le programme possède trois niveaux d’accès. Les sections suivantes 
traitent du niveau Administrator (Administrateur), car il dispose du plus grand nombre 
de fonctionnalités. Le niveau de base permet uniquement une consultation en lecture 
seule, tandis que le niveau « Data Manager » (Gestionnaire de données) permet de lire 
le journal de données et d’accéder à la configuration sans pouvoir les modifier. 
Le niveau Basic User (Utilisateur de base) ne nécessite aucun mot de passe.  
 
Tapez le mot de passe, puis cliquez sur « OK ».  
 
Remarque : le mot de passe par défaut est  « rae ». Ce mot de passe vous donne un 
accès complet. Vous pourrez le modifier ultérieurement (reportez-vous à la page 16).  
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8. Barre d’outils principale 
 
En haut de la fenêtre principale de ProRAE Studio II, se trouvent cinq boutons : 
 

 
 
 

Bouton Fonction 

 
Ouvrir un fichier ProRAE Studio 

 
Enregistrer les données actuelles dans un fichier 

 
Détecter automatiquement les instruments 

 
Détecter manuellement les instruments 

 
Options de configuration 

 
Ces boutons sont identiques aux options textuelles qui se trouvent juste au-dessus dans 
les menus « File » (Fichier) et « Operation » (Opération), mais présentent une structure 
organisationnelle différente. Quelques différences existent toutefois. Sous « File » 
(Fichier), deux options d’enregistrement différentes s’affichent (« Save » (Enregistrer) 
qui correspond à un enregistrement simple et « Save As… » (Enregistrer sous...), pour 
enregistrer le fichier sous un nouveau nom). En outre, le menu comporte une option 
« Change Password… » (Changer le mot de passe...) et une commande Exit (Quitter). 
À noter également la présence d’une option « Help » (Aide). 
 
File (Fichier) 
 Open… (Ouvrir...) 
 Close (Fermer) 
 Save (Enregistrer) 
 Save As… (Enregistrer sous...) 
 Change Password… (Changer le mot de passe...) 
 Exit (Quitter) 
 
Operation (Opération) 
 Auto Detect (Détection auto) 
 Manual Detect (Détection manuelle) 
 Setup… (Configuration...) 
 Language (Langue) 
 
Help (Aide) 
 About… (À propos de...)  
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8.1. Modification du mot de passe 
 
ProRAE Studio II comporte deux mots de passe différents pour le niveau Data Manager 
(Gestionnaire de données) et le niveau Administrator (Administrateur). (Aucun mot de 
passe n’est nécessaire pour le niveau Basic User (Utilisateur de base)). 
 

1. Sélectionnez le mot de passe à modifier. 
2. Tapez le nouveau mot de passe. 
3. Retapez le nouveau mot de passe. 
4. Cliquez sur « OK ». 

 
Remarque : les mots de passe sont sensibles à la casse. 
 

 
 
Les deux mots de passe que vous saisissez doivent être identiques. Si c’est le cas, 
le message suivant s’affiche : 
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Cliquez sur « OK » pour revenir à l’écran principal. 
 
Si vous avez saisi deux mots de passe différents, le message suivant s’affiche : 
 

 
 
Cliquez sur « OK » pour faire disparaître ce message, puis retapez les mots de passe. 
 
Remarque : si vous oubliez votre mot de passe, utilisez le CD-ROM d’installation pour 
réinstaller le programme. Le mot de passe par défaut est alors restauré. 
 

8.2. Détection automatique 
 
Si vous utilisez une base AutoRAE 2 : vous devez basculer la base AutoRAE 2 en mode de 
communication PC avant d’essayer de la détecter à l’aide de ProRAE Studio II. Maintenez 
enfoncé le bouton de déclenchement jusqu’à ce que la mention « PC » apparaisse à l’écran : 
 
Avant de procéder à toute autre opération, vous devez commander à ProRAE Studio II 
de détecter un instrument. La fonction Automatic Detect (Détection automatique) est 
pratique puisqu’elle ne nécessite qu’un clic sur un bouton. 
 
Pour détecter automatiquement un instrument, cliquez sur le bouton Automatic Detect 
(Détection automatique) : 
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La boîte de dialogue Automatic Detect (Détection automatique) s’ouvre et le processus 
de détection démarre. Lorsqu’un instrument est détecté, il apparaît comme suit : 
 

 
 
L’instrument affiché dépend du modèle qui est connecté à l’ordinateur. Pour continuer, 
sélectionnez un instrument. Si vous cliquez sur « Cancel » (Annuler), aucun instrument 
n’est sélectionné et la boîte de dialogue se ferme. 
 
Remarque : si votre ordinateur n’arrive pas à se connecter à un instrument, cliquez sur 
« Refresh » (Actualiser). Si l’instrument souhaité ne s’affiche pas, vérifiez les câbles, 
l’instrument et le numéro de port. Si vous avez déjà sélectionné un instrument, ouvert 
à nouveau la boîte de dialogue de détection automatique et cliqué sur « Select » 
(Sélectionner), la boîte de dialogue suivante s’affiche : 
 

 
 
Si vous cliquez sur « Yes » (Oui), les données sont extraites de l’instrument sélectionné 
et écrasent les données présentes dans ProRAE Studio II. Si vous cliquez sur « No » (Non), 
les données ne sont pas écrasées et la boîte de dialogue se ferme. 
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8.3. Détection manuelle 
 
Vous souhaitez peut-être détecter manuellement un instrument s’il ne s’affiche pas dans 
la liste lorsque vous cliquez sur Automatic Detection (Détection automatique). En outre, 
ce mode de détection peut être plus rapide que la détection automatique, puisqu’il ne 
vérifie pas tous les ports COM existants. 
 

 
 
Avant de cliquer sur le bouton Manual Detection (Détection manuelle), vous devez 
cliquer sur le bouton Setup Options (Options de configuration) et définir le port COM : 
 

 
 
 
 
La boîte de dialogue Configuration s’ouvre : 
 

  



Guide de l’utilisateur ProRAE Studio II version 1.5 

 Page 20  

Cliquez sur « Refresh » (Actualiser) pour actualiser les sélections de port COM. Ensuite, 
déroulez le port COM approprié qui correspond à l’emplacement de l’instrument. Vous 
pouvez sélectionner le débit en bauds de la communication (la vitesse de transfert des 
données), ou cliquer simplement sur « Auto » et laisser le programme déterminer la vitesse 
de transfert optimale. 
 
Cliquez à présent sur « OK ». La configuration est terminée. 
 
Lorsque vous cliquez sur le bouton de détection manuelle, la boîte de dialogue suivante 
affiche des renseignements relatifs à l’instrument sélectionné : 
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Cliquez sur « OK » pour charger les renseignements relatifs à l’instrument dans ProRAE 
Studio II. Une boîte de dialogue d’avertissement s’affiche : 
 

 
 
Si vous cliquez sur « Yes » (Oui), les données sont extraites de l’instrument sélectionné 
et écrasent les données présentes dans ProRAE Studio II. Si vous cliquez sur « No » (Non), 
les données ne sont pas écrasées et la boîte de dialogue se ferme. 
 

9. Module de configuration 
 
Une fois le mode de détection manuelle ou automatique sélectionné, certains ou tous les 
boutons suivants apparaissent sur le rebord gauche de l’écran. 
 

 
 
Remarque : les icônes/options disponibles dépendent du mode de fonctionnement et de 
l’instrument. 
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En mode Data Manager (Gestionnaire de données), seuls les boutons Setup (Configuration), 
Datalog (Journal de données) et Gas (Gaz) sont affichés. En mode Basic User (Utilisateur 
de base), seuls les boutons Setup (Configuration) et Gas (Gaz) sont affichés. 
 
Cliquez sur « Setup » (Configuration) pour configurer ProRAE Studio II en téléchargeant 
les données à partir de l’instrument : 
 

 
 
Une barre de progression s’affiche et indique que les données sont en cours de transfert. 
Le processus dure quelques secondes (le temps écoulé est indiqué). 
 

 
 
Une fois la configuration terminée, l’écran affiche les données transmises par l’instrument. 
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Contrôleur ou base AutoRAE 2 : si vous utilisez une base AutoRAE 2 ou un contrôleur 
AutoRAE 2, l’écran de configuration est semblable à celui-ci : 
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Le nom de l’instrument apparaît en haut, ainsi que le modèle et le numéro de série. 
Dans le volet gauche de la fenêtre, une arborescence de commandes comprend tous les 
paramètres que vous pouvez consulter et ajuster. Lorsque vous cliquez sur l’un des 
éléments de l’arborescence, un nouveau paramètre est sélectionné et les renseignements 
correspondants apparaissent dans le volet droit. 
 
Voici deux exemples. Notez la manière dont les données dans le volet droit changent 
lorsqu’une sélection est effectuée dans le volet gauche. 
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9.1. Barre d’outils Configuration 
 
Une barre d’outils, également disponible sur le volet droit, permet de déplacer les données 
de configuration de et vers l’instrument. 

 
 

9.1.1. Résumé des fonctions des boutons de la barre d’outils  
          de configuration 
 
Bouton Fonction 

 
Met à jour la configuration de l’élément actuel à partir du même instrument 

 
Définit la configuration de l’élément actuel à partir du même instrument 

 
Télécharge la configuration de tous les éléments à partir du même instrument 

 
Charge la configuration de tous les éléments sur le même instrument 

 

Charge la configuration de tous les éléments sur le même instrument, sans 
vérifier le numéro de série 

 

Si vous sélectionnez la racine de l’arborescence, le bouton devient bleu 
(au lieu de gris) et vous pouvez exporter les données de configuration vers un 
fichier texte. 

 
Remarque : une icône en forme d’antenne le long de la barre d’outils indique que 
l’instrument est doté d’une fonction sans fil. 
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10. Module Datalog (Journal de données) 
 
Cliquez sur le bouton intitulé « Datalog » (Journal de données) pour accéder aux données 
du journal de données de l’instrument. 
 

IMPORTANT! 
Contrôleur AutoRAE 2 : si vous utilisez un contrôleur AutoRAE 2 avec un ordinateur qui 
exécute ProRAE Studio II, reportez-vous à la page 11, « Transfert des données du contrôleur 
AutoRAE 2 sur un ordinateur, » pour plus de détails sur le téléchargement des données. 
 

 
 
La fenêtre Datalog (Journal de données) s’affiche dans le volet droit et le bouton « Datalog » 
(Journal de données) est mis en surbrillance. 
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10.1. Résumé des fonctions des boutons du journal de données 
 
Bouton Fonction 

 Trier 

 
Inverser l’ordre de tri 

 
Afficher le numéro d’enregistrement 

   
Développer ou réduire 

 
Actualiser (mettre à jour) les renseignements sur l’événement 

 
Télécharger toutes les données 

 Télécharger des événements sélectionnés 

 Télécharger l’événement actuel 

 Résumé (des événements actuels) 

 
Feuille (vue sous forme de feuille de calcul de toutes les données de 
l’événement actuel) 

 Graphique (ligne de tendance des données de l’événement actuel) 

 TWA/STEL 

 Exporter les événements sélectionnés 

 Options d’exportation 

 Filtrer 

 Effacer le journal de données 

 
 Trier et inverser l’ordre de tri  Utilisez ces deux boutons pour trier les 

événements selon un ordre séquentiel ou en ordre inverse. 
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 Afficher le numéro d’enregistrement. Ce bouton vous permet de choisir si c’est le 
nom de l’événement ou le numéro d’enregistrement qui s’affiche dans la liste de gauche. 
 

 
 

   Développer/Réduire. Développe ou réduit les données dans la colonne. 
 

 Actualiser les renseignements sur l’événement. Lorsque vous cliquez sur ce bouton, 
les événements sont téléchargés. Remarque : cela ne fonctionne pas sur tous les 
instruments. 
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Cinq boutons placés le long du côté droit offrent les options suivantes : 
 
Bouton Fonction 
Automatic 
(Automatique) Télécharge les événements qui n’ont pas encore été téléchargés. 

Checked Only 
(Coché uniquement) Télécharge uniquement les événements cochés 

Download All 
(Télécharger tout) 

Télécharge tous les événements Il agit comme le bouton Download 
Data (Télécharger les données) ( ) 

Just Update (Mettre 
à jour seulement) Il met seulement à jour la liste des éléments vers le contrôle de liste 

Cancel (Annuler) Annule tout (n’exécute aucune action et retourne à l’écran principal)
 

 
 Télécharger toutes les données. Télécharge toutes les données du journal de données. 

 

 Télécharger des événements sélectionnés. Télécharge uniquement les éléments 
que vous avez sélectionnés dans la liste. Si vous souhaitez télécharger des événements 
directement à partir de l’affichage du journal de données, vous pouvez sélectionner 
plusieurs événements en appuyant sur la touche « Maj » tout en cliquant sur le bouton 
gauche de la souris. (Ctrl-clic sur chaque événement). Cliquez ensuite sur le bouton 
droit de la souris pour sélectionner « Download Selected Event(s) » (Télécharger les 
événements sélectionnés) dans le menu contextuel, comme illustré ci-dessous : 
 

 
 
D’autres options vous permettent d’exporter des événements sélectionnés, de modifier 
leur ordre de tri et même de les renommer. 
 

 Télécharger l’événement actuel. Même s’il est possible de sélectionner plusieurs 
événements simultanément, il n’existe qu’un seul événement actif. L’événement actif est 
l’événement actuel. Son contenu est affiché dans la fenêtre du journal de données. 
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 Résumé. Cette option permet d’afficher les renseignements récapitulatifs sur 
l’événement actuel. 
 

 
 

 Feuille. La feuille affiche toutes les données relatives à l’événement actuel. 
 

 
 
Remarque : vous pouvez copier le contenu de cette feuille si vous souhaitez le coller 
dans un rapport, etc. Utilisez la combinaison Maj-clic gauche pour sélectionner et Ctrl-C 
pour copier. (La plupart des programmes vous permettent d’utiliser la combinaison Ctrl-V 
pour coller, mais consultez le guide de l’utilisateur de votre programme pour vous en 
assurer). 
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Graphique. Le graphique affiche la ligne de tendance des données de l’événement 
actuel. Lorsque vous sélectionnez la vue graphique, une barre d’outils supplémentaire 
apparaît, comportant des options de visualisation. 
 

 
 
Bouton Fonction 

 
Zoom avant 

 
Zoom arrière 

 
Ajuster à la largeur 

 
Ajuster à la hauteur 

 
Ajuster à la page 

 
Graphique de points et de lignes 

 
Graphique en points uniquement 

 
Graphique en lignes uniquement 

 
Afficher/Masquer informations X et Y 

 
Afficher/Masquer axe (graphique en lignes) 

 
Afficher/Masquer notes 

 
Voici des exemples de deux vues graphiques différentes : 
 

 
 

Remarque : vous pouvez déplacer le graphique dans la fenêtre en cliquant et en le 
faisant glisser avec la souris. 
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Les options de zoom avant et zoom arrière vous permettent d’afficher le graphique en 
plusieurs dimensions et se révèlent utiles lors de l’examen de données denses. 
 
Ajuster à la largeur, Ajuster à la hauteur et Ajuster à la page permettent également 
de disposer de différentes vues, de réduire ou de développer la zone de graphique selon 
vos besoins. 
 
Les styles de graphiques Points et lignes, Points uniquement et Lignes uniquement 
changent les références afin de vous permettre de visualiser différentes représentations 
des données avec plus ou moins de renseignements de référence. Il n’est possible de 
sélectionner qu’une seule de ces options à la fois. 
 
Afficher/Masquer les informations X et Y vous permet d’activer ou de désactiver 
l’infobulle qui suit votre curseur lorsque vous déplacez la souris. La fenêtre d’infobulle 
affiche les emplacements du curseur sur les axes X et Y de la grille, ce qui est très utile 
lors de discussions sur les emplacements et les tendances. 
 

 
Afficher/Masquer les lignes de graphique, comme son nom l’indique, active et désactive 
la grille horizontale et verticale derrière le graphique. 
 
Afficher/Masquer notes vous permet de visualiser une partie du graphique accompagnée 
d’une étiquette qui vous indique ce que représente la ligne. La petite boîte de dialogue 
indique la couleur de la ligne; elle vous permet d’afficher ou de masquer la ligne en cliquant 
sur la case à cocher et de définir l’opacité de la boîte de dialogue (50 % ou 100 %). Une 
valeur d’opacité inférieure rend la boîte de dialogue plus transparente. 
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 TWA/STEL. Cette option fait référence aux valeurs de moyenne pondérée dans 
le temps (TWA, time-weighted average) et de limite d’exposition à court terme (STEL, 
short-term exposure limit). Les valeurs affichées à l’écran ne proviennent pas de 
l’instrument, mais sont calculées par ProRAE Studio II. En règle générale, vous devez 
définir le type de mesure de l’instrument pour obtenir des valeurs TWA/STEL précises. 
Reportez-vous à la Note technique RAE Systems TN-119 pour plus de renseignements 
sur le calcul des valeurs TWA et STEL. 
 

 Exporter les événements sélectionnés.  Exporte les événements sélectionnés 
au format texte (.txt). Vous pouvez sélectionner plusieurs événements et les exporter 
simultanément vers un fichier unique. Sélectionnez les événements dans la liste en 
utilisant la combinaison Ctrl-clic sur chaque élément à sélectionner. Une fois les éléments 
mis en surbrillance, cliquez sur le bouton Export Options (Options d’exportation). Une 
boîte de dialogue s’affiche, qui vous permet de sélectionner l’emplacement du fichier 
et de le nommer (le nom par défaut contient « PRS_EXPORT » suivi par la date; par 
exemple, PRS_EXPORT_2010407.txt). 
 

 Options d’exportation.  Lorsque vous cliquez sur ce bouton, la boîte de dialogue 
suivante contenant deux options s’affiche : 
 

 
 
Vous pouvez choisir d’exporter les données TWA/STEL et d’enregistrer les données 
séparées par une tabulation au lieu d’une virgule sur chaque ligne (cette option est utile 
pour les fichiers qui seront ensuite importés vers des feuilles de calcul telles que 
Microsoft Excel). 
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Menu contextuel (par un clic-droit) 
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 Filtrer.  Une fois que vous avez sélectionné un événement, vous pouvez le filtrer 
en fonction de plages de valeur et de temps, ce qui est utile si vous souhaitez afficher 
uniquement les données dans une plage de valeurs TWA ou STEL spécifique. Lorsque 
vous cliquez sur le bouton Filter (Filtrer), la fenêtre suivante s’affiche : 
 

 
 
Time Filter (Filtre de temps). Définissez les valeurs de temps et de date en cliquant sur 
la portion que vous souhaitez modifier puis en écrasant la valeur existante ou en utilisant 
les flèches haut/bas à droite de chaque champ pour augmenter/diminuer la valeur. 
 

     
 

Si vous cliquez sur Begin (Début) ou End (Fin) à tout moment, le réglage inverse l’heure 
de début ou de fin, respectivement, enregistrée dans l’événement. 
 
Value Filter (Filtre de valeur). S’il existe plusieurs valeurs, vous pouvez en sélectionner 
une à l’aide du menu déroulant. Puis définissez les valeurs dans les champs « From » 
(À partir de) et « To » (Vers). Une fois terminé, cliquez sur « OK ». Si vous souhaitez 
supprimer le filtre, cliquez sur « Remove Filter » (Supprimer le filtre). 
 
Si vous cliquez sur Minimum ou Maximum à tout moment, le réglage inverse la valeur 
minimum et maximum, respectivement, enregistrée dans l’événement. 
 
Remarque : si vous modifiez des événements, le filtre est automatiquement désactivé. 
 

 Erase Datalog (Effacer le journal de données). Si vous cliquez sur cette option, 
le journal de données de l’instrument est automatiquement effacé. 
 
ATTENTION! Si vous effacez le journal de données, il ne sera pas possible de le 
restaurer, toutes les données seront supprimées. Par conséquent, si vous devez conserver 
les renseignements du journal de données, enregistrez-le au préalable. 
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11. Transfert des données du contrôleur AutoRAE 2 
      sur un ordinateur 
Les données d’étalonnage et de vérification sont collectées à chaque fois qu’un instrument 
fait l’objet d’une vérification ou qu’il est étalonné. Le contrôleur AutoRAE 2 collecte les 
données et les stocke sur une carte SD, ce qui constitue un moyen pratique de stockage 
et de transfert des données. 
 
Suivez la procédure ci-dessous pour lire les données de test d’étalonnage et de 
vérification à partir d’un contrôleur AutoRAE 2. 
 

1. Connectez un câble USB au contrôleur AutoRAE 2 et à un ordinateur sur lequel 
le logiciel ProRAE Studio II est exécuté. 

2. Assurez-vous que le contrôleur AutoRAE 2 est sous tension et qu’il est allumé. 
3. Exécutez le logiciel ProRAE Studio II sur l’ordinateur. 

Remarque : vous pouvez obtenir des rapports avec n’importe quel niveau de 
privilège d’accès. 

4. Cliquez sur « Detect the instruments automatically » (Détecter automatiquement 
les instruments) (icône en forme de loupe contenant la lettre « A »). Au bout de 
quelques secondes, le contrôleur AutoRAE 2 est détecté et affiché, ainsi que la 
version de son microprogramme, son numéro de série et le port COM. 

5. Cliquez sur « Select » (Sélectionner). 
  

 
 

L’écran suivant apparaît : 
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6. Développez Online (En ligne) ou Offline (Hors-ligne) pour afficher les instruments. 
7. Cliquez sur « Instruments ». 

 

 
 
Les instruments ayant subi un test de vérification et ayant été étalonnés sur un système 
avec ce contrôleur AutoRAE 2 sont affichés : 
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8. Double-cliquez sur un instrument pour afficher ses rapports. 
 

 
 
La fenêtre Reports (Rapports) de cet instrument s’ouvre. 
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9. Cliquez sur « Reports » (Rapports) et la fenêtre change. 
 

 
 

10. Cliquez sur le bouton « Download All Reports » (Télécharger tous les rapports) : 
 

 
 

S’il n’y a aucun rapport, une alerte apparaît : 
 

 
 

Si des rapports sont présents, ils sont téléchargés et placés dans une liste dans la colonne 
de gauche : 
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Si cette liste est longue, vous pouvez en modifier l’ordre afin d’inverser l’ordre de tri 
(de 001, 002, 003, etc. à 003, 002, 001, etc.). Appuyez sur l’un de ces deux boutons pour 
inverser l’ordre de tri : 
 

   
 

11. Sélectionnez un rapport en cliquant sur la date et le numéro du rapport. 
 

 
 
Remarque : vous pouvez changer le nom du rapport en double-cliquant sur son nom puis 
en le modifiant dans la boîte de dialogue qui s’affiche : 
 

 
 

12. Une fois terminé, cliquez sur « OK ». 
 
Attention! Une fois que vous avez modifié le nom du rapport et cliqué sur « OK », 
la modification ne peut pas être annulée. Si vous souhaitez restaurer le nom d’origine 
du rapport, vous devez le saisir dans les renseignements. 
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Une fois un ensemble de rapports mis en surbrillance, cliquez sur l’un des trois types de 
rapport suivants : 
 

 
Rapport d’étalonnage 

 
Rapport de test de vérification 

 
Rapport de violation de politique 

 
Un rapport d’étalonnage ou de test de vérification est illustré dans la fenêtre de droite : 
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Vous trouverez ci-dessous un exemple de rapport d’étalonnage (un rapport de vérification 
est très semblable) : 
 

RAE Systems Inc. 
CERTIFICAT D’ÉTALONNAGE 
Nº:____________________ 

 
RÉSUMÉ D’ÉTALONNAGE 
 
Étalonnage air frais  Réussi 
Étalonnage à zéro  S/O 
Étalonnage sur échelle  Réussi 
Étalonnage sur échelle 2  S/O 
 
Action recommandée  ______________________________ 
 
Étalonnage effectué le  2012/05/14 17:17:45 
 
Instrument testé 
Nom du produit  MultiRAE Lite 
Nom du modèle  PGM‐6200 
Microprogramme  V1.10  
Numéro de série  MAB10101N4 
 
Système d’étalonnage et de test automatique AutoRAE 2 
  Contrôleur    Base     
Nom du produit  Contrôleur AutoRAE 2  MultiRAE Pumped   
Nom du modèle  DKS‐6000    DKS‐6001   
Microprogramme  V1.00     V1.00    
Numéro de série  F0xx000001    F011DEMO11   
 
RÉSULTATS DÉTAILLÉS DE L’ÉTALONNAGE 
 
Alarme audible  Réussi 
Alarme visuelle  Réussi 
 
Résultats de l’étalonnage d’air frais 
Capteurs activés  Gaz  Conc.  Valeur  Résultat 
LEL(%LEL)  Air frais  0  0  Réussi   
H2S(ppm)  Air frais  0.0  0.0  Réussi   
CO(ppm)  Air frais  0  0  Réussi   
VOC(ppm)  Air frais  0  0  Réussi   
 
Résultats de l’étalonnage à zéro 
Capteurs activés  Gaz  Conc.  Valeur  Résultat 
LEL(%LEL)  S/O  S/O  S/O  S/O   
H2S(ppm)  S/O  S/O  S/O  S/O   
CO(ppm)  S/O  S/O  S/O  S/O   
VOC(ppm)  S/O  S/O  S/O  S/O   
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Résultats de l’étalonnage sur la période 
Capteurs activés  Gaz  Conc.  Valeur  Résultat 
LEL(%LEL)  LEL  50  50  Réussi   
H2S(ppm)  H2S  10.0  10.2  Réussi   
CO(ppm)  CO  50  50  Réussi   
VOC(ppm)  2‐méthylprop‐1‐ène  100  100  Réussi   
 
Résultats de l’étalonnage sur la période 2 
Capteurs activés  Gaz  Conc.  Valeur  Résultat 
LEL(%LEL)  S/O  S/O  S/O  S/O   
H2S(ppm)  S/O  S/O  S/O  S/O   
CO(ppm)  S/O  S/O  S/O  S/O   
VOC(ppm)  S/O  S/O  S/O  S/O   
 
RENSEIGNEMENTS SUR LE CAPTEUR 
Capteurs installés  Numéro de série  Statut 
LEL(%LEL)  03115172N3  Activé   
OXY(%)  03420034MC  Désactivé   
H2S(ppm)  03070137MC  Activé   
CO(ppm)  03060034N1  Activé   
VOC(ppm)  03A30024N3  Activé   
 
Paramètres d’alarme  Faible  Élevé  STEL  TWA 
LEL(%LEL)  10  20  S/O  S/O   
OXY(%)  19.5  23.5  S/O  S/O   
H2S(ppm)  10.0  20.0  15.0  10.0   
CO(ppm)  35  200  100  35   
VOC(ppm)  50  100  25  10   
 
Étalonnage suivant Échéance  Le  Dans 
LEL(%LEL)  2012/06/13  30 jours   
OXY(%)  2011/07/31  0 jour   
H2S(ppm)  2012/06/13  30 jours   
CO(ppm)  2012/06/13  30 jours   
VOC(ppm)  2012/06/13  30 jours   
 
Expiration de la garantie :  Le  Dans 
LEL(%LEL)  2013/05/23  374 jours   
OXY(%)  2013/03/03  293 jours   
H2S(ppm)  2013/05/10  361 jours   
CO(ppm)  2013/05/10  361 jours   
VOC(ppm)  2012/06/21  38 jours 
 

11.1. Exportation de rapports 
Le rapport peut être exporté pour être archivé ou envoyé. Il peut être enregistré au format 
Rich Text Format (.rtf), ce qui facilite son importation dans la plupart des programmes 
de traitement de texte tels que Microsoft Word, ou il peut être enregistré au format texte 
(.txt). Cliquez sur ce bouton, recherchez l’emplacement d’enregistrement du fichier, 
sélectionnez le type de fichier (RTF ou TXT), renommez-le au besoin, puis cliquez sur 
« Save » (Enregistrer).  
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11.2. Enregistrement d’une configuration en quittant 
Lorsque vous fermez ProRAE Studio II après avoir téléchargé les rapports et appliqué 
des modifications, l’invite suivante s’affiche : 
 

 
 
Si vous ne souhaitez pas enregistrer les modifications apportées à la configuration, cliquez 
sur « No » (Non). Si vous souhaitez enregistrer les modifications, cliquez sur « Yes » (Oui). 
Sélectionnez le nom du fichier qui sera enregistré comme fichier de configuration de 
ProRAE Studio avec une extension « .prs » et sélectionnez l’emplacement d’enregistrement. 
Cliquez ensuite sur « Save » (Enregistrer).   
 
 

12. Utilisation d’une base AutoRAE 2 autonome pour  
      le transfert du journal de données, la configuration  
      du moniteur et les mises à niveau du microprogramme 
Les journaux de données peuvent être téléchargés d’un instrument MultiRAE sur un 
ordinateur, et les mises à jour du microprogramme et les données de configuration 
peuvent être chargées sur un instrument MultiRAE via le port USB d’une base AutoRAE 2 
autonome. Utilisez le câble USB fourni pour connecter la base AutoRAE 2 à un ordinateur 
qui exécute ProRAE Studio II (version 1.5 ou supérieure). 
 
Suivez les instructions de la section 10 du guide de l’utilisateur de l’instrument 
MultiRAE pour plus de détails sur l’accès aux journaux de données et sur les autres 
procédures des instruments de la famille MultiRAE. 
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13. Module de gaz 
 
Pour accéder au module de gaz, il suffit de cliquer sur le bouton intitulé « Gas » (Gaz). 
Ce module vous fournit des renseignements sur le(s) gaz au(x)quel(s) votre instrument est 
étalonné et vous permet de les gérer. 
 

 
 
Lorsque vous cliquez sur Gas (Gaz) pour la première fois au cours d’une session, une 
boîte de dialogue et une barre de progression s’affichent et indiquent que les données 
de configuration sont en cours de téléchargement de votre instrument sur l’ordinateur. 
 

 
 

Important : le bouton « Gas » (Gaz) est 
disponible uniquement pour les instruments 
équipés du capteur PID de RAE Systems. 
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La fenêtre Gas Setup (Configuration des gaz) est alors remplie de données provenant de 
l’instrument. 
 

 
 
Quatre gros boutons permettent de sélectionner les vues des différentes données : 
 

• Custom Gas List (Liste des gaz personnalisée) 
• My Gas List (Ma liste de gaz) 
• Last Ten Gas List (Liste des dix derniers gaz) 
• Calibration Reference (Référence de calibrage) 

 
Les listes Custom Gas List (Liste des gaz personnalisée)et My Gas List (Ma liste de gaz) 
peuvent être modifiées et chargées sur l’instrument, mais les deux autres sont accessibles 
en lecture seule. 
 
La liste Custom Gas List (Liste des gaz personnalisée)a été ajoutée au cas où vous 
n’arriveriez pas à trouver les renseignements relatifs à un gaz dans la bibliothèque intégrée. 
Vous définissez des renseignements sur un nouveau gaz pour huit gaz ou moins dans la 
liste Custom Gas List (Liste des gaz personnalisée). 
 
La liste My Gas List (Ma liste de gaz) regroupe les gaz les plus fréquemment utilisés. 
Vous pouvez les choisir dans la bibliothèque des gaz de RAE Systems ou dans la liste des 
gaz personnalisée. Cela réduit le temps nécessaire pour passer d’un gaz à l’autre, car avec 
10 éléments, cette liste est bien plus courte que la bibliothèque des gaz standard qui 
contient 222 éléments. 
 
La liste Last Ten Gas List (Liste des dix derniers gaz) inclut les 10 sélections de gaz 
les plus récentes de la bibliothèque RAE Systems ou de la liste des gaz personnalisée. 
 
Les références d’étalonnage stockent les renseignements d’étalonnage relatifs à différents 
gaz.  Sans référence d’étalonnage, l’utilisateur doit recalibrer le capteur à chaque fois qu’il 
change le gaz de réglage d’échelle.  Les références d’étalonnage permettent de mesurer 
jusqu’à huit gaz si les étalonnages ont été effectués et enregistrés à l’avance.  La référence 
d’étalonnage 1 utilise toujours de l’isobutylène comme gaz de réglage d’échelle et 
l’utilisateur peut changer le gaz de mesure et le facteur de correction qui accompagne le 
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gaz. La référence d’étalonnage 2 à 7 peut utiliser tous les gaz comme gaz de réglage 
d’échelle mais ne peut pas changer le gaz de mesure, ce qui signifie que CF est toujours 
égal à 1. 
 
Remarque : vous pouvez copier les données à coller dans d’autres documents (Microsoft 
Word, etc.) en cliquant sur un champ et en le faisant glisser pour sélectionner la zone. 
Cliquez ensuite sur Ctrl-C pour copier. Collez le texte extrait dans un document en 
utilisant la combinaison Ctrl-V (cela fonctionne dans la plupart des programmes, sinon, 
consultez le guide de l’utilisateur du logiciel). 
 
Deux boutons plus petits permettent de récupérer les données de l’instrument (intitulé 
« Get » (Obtenir)) et de charger les données sur l’instrument (« Set » (Définir)). 
 
Vous pouvez modifier les noms des gaz et d’autres données du tableau, qui peuvent être 
chargées sur l’instrument. 
 
Remarque : si vous cliquez sur « Get » (Obtenir), les nouvelles données sont extraites 
de l’instrument et écrasent les données de la fenêtre ProRAE Studio II. 
 
Lorsque vous cliquez sur « Set » (Définir), les données de configuration du gaz sont 
envoyées vers l’instrument. Pour confirmer que vous souhaitez effectuer cette action 
(et écraser les données existantes), l’invite suivante s’affiche : 
 

 
 
Si vous cliquez sur « Yes » (Oui), la configuration de gaz que vous avez créée ou modifiée 
dans ProRAE Studio II écrase celles présentes dans l’instrument. Si vous acceptez, les 
anciens paramètres sont supprimés et ne peuvent plus être restaurés. 
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14. Module de microprogramme 
 
Le module de microprogramme contacte le programmeur correspondant à l’instrument 
sélectionné afin de mettre à jour le microprogramme (si une nouvelle version est 
disponible). 
 

 
 
Les renseignements relatifs à l’instrument sont affichés dans le volet droit, et un bouton 
vous permet d’appeler le programmeur de l’instrument. Les renseignements relatifs à 
l’instrument sélectionné et à sa version de microprogramme sont illustrés ci-dessous; un 
bouton permet d’invoquer le programmeur. 
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Remarque : le programmeur correct doit se trouver dans le dossier approprié pour 
fonctionner. Généralement, ces renseignements sont configurés correctement à l’installation 
du logiciel. Cependant, vous devrez peut-être vous assurer que le numéro de port COM 
approprié est utilisé. 
 

 
 

14.1. Mise à jour du microprogramme sur la base AutoRAE 2 
Les mises à jour du microprogramme de la base AutoRAE 2 peuvent être générées et 
chargées dans la base AutoRAE 2 à l’aide du logiciel ProRAE Studio II exécuté sur un 
ordinateur personnel. 
 
1. Téléchargez le microprogramme depuis le site Web de RAE Systems ou depuis un 

CD-ROM. 
2. Connectez un ordinateur qui exécute ProRAE Studio II à la base AutoRAE 2 à l’aide 

d’un câble USB. 
3. Maintenez enfoncé le bouton de déclenchement jusqu’à ce que la mention « PC » 

apparaisse à l’écran : 
4. Démarrez ProRAE Studio II. 
 

 
 
5. Cliquez sur « Administrator » (Administrateur). 
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6. Saisissez le mot de passe (le mot de passe par défaut est « rae »). 
 

 
 
7. Cliquez sur « OK ». 
8. Cliquez sur « Detect the instruments automatically » (Détecter l’instrument 

automatiquement). 
 

 
 

9. Sélectionnez la base AutoRAE 2. 
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10. Cliquez sur « Select » (Sélectionner). 
 

 
 

11. Les deux options à gauche sont « Setup » (Configuration) et « Firmware » 
(Microprogramme). Cliquez sur « Firmware » (Microprogramme). 

 

 
 

12. Cliquez sur « Run Programmer » (Exécuter le programmeur).  
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La fenêtre RAE Programmer 4000 (Programmeur RAE 4000) s’ouvre : 
 

 
 

13. Cliquez sur le bouton intitulé « Open… » (Ouvrir...). 
 

 
 
14. Recherchez, puis sélectionnez le fichier du microprogramme portant l’extension « .rfp ». 
 

 
 

15. Cliquez sur « Open » (Ouvrir). 
 

 
 

16. Cliquez sur « Start » (Démarrer). 
 

 
 

17. Le microprogramme est chargé sur la base AutoRAE 2. 
18. Quittez le mode de communication PC sur la base AutoRAE 2 en maintenant 

enfoncée la touche de déclenchement. L’affichage doit désormais indiquer « G8 ». 
19. Quittez le logiciel ProRAE Studio II sur l’ordinateur. 
20. Débranchez le câble USB. 
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14.2. Mise à jour du microprogramme sur le contrôleur  
         AutoRAE 2 
Les mises à jour du microprogramme du contrôleur AutoRAE 2 peuvent être générées et 
chargées sur le contrôleur AutoRAE 2 à l’aide du logiciel ProRAE Studio II exécuté sur 
un ordinateur personnel. 
 
1. Téléchargez le microprogramme depuis le site Web de RAE Systems ou depuis un 

CD-ROM. 
2. Connectez un ordinateur qui exécute ProRAE Studio II au contrôleur AutoRAE 2 

à l’aide d’un câble USB. 
3. Démarrez ProRAE Studio II. 
 

 
 
4. Cliquez sur « Administrator » (Administrateur). 
 

 
 
5. Saisissez le mot de passe (le mot de passe par défaut est « rae »). 
 

 
 

6. Cliquez sur « OK ». 
7. Cliquez sur « Detect the instruments automatically » (Détecter l’instrument 

automatiquement). 
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8. Sélectionnez le contrôleur AutoRAE 2. 
 

 
 

9. Cliquez sur « Select » (Sélectionner). 
 

 
 

10. Le contrôleur AutoRAE 2 apparaît, ainsi que son numéro de série. 
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11. Double-cliquez sur l’icône du contrôleur AutoRAE 2; l’écran suivant s’affiche :  
 

 
 
12. Cliquez sur le bouton « Firmware » (Microprogramme). La fenêtre suivante 

s’ouvre : 
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13. Cliquez sur la zone intitulée « Upgrade for specific SN » (Mise à niveau du numéro 
de série spécifique) et déroulez le menu pour sélectionner le numéro de série 
correspondant à celui affiché dans la partie supérieure droite de la fenêtre. 

 

 
 
14. Cliquez sur « Upload Firmware » (Charger le microprogramme). 
15. Recherchez, puis sélectionnez le fichier du microprogramme portant l’extension « .rfp ». 

 

 
 

16. Cliquez sur « Open » (Ouvrir). 
 

 
 

17. Le fichier de microprogramme est chargé sur la carte SD du contrôleur AutoRAE 2 
et le contrôleur AutoRAE 2 transmet le microprogramme à la base AutoRAE 2 ou 
MultiRAE (Pumped), respectivement. 

18. Quittez le logiciel ProRAE Studio II sur l’ordinateur. 
19. Débranchez le câble USB. 
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15. Outil de configuration de l’utilisateur 
Cet outil offre une autre manière de configurer l’instrument. Il est très simple d’utilisation 
et utilise les commandes stockées dans un fichier « .ezcfg », fourni par RAE Systems. 
 
Remarque : cet outil n’est utilisé ni avec le contrôleur AutoRAE 2 ni avec la base 
AutoRAE 2. 
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Cliquez sur le bouton intitulé « Tool » (Outil); le volet droit est renseigné. 
 

 
 
Cliquez sur le bouton « Select Folder » (Sélectionner dossier). La boîte de dialogue 
« Browse For Folder » (Rechercher un dossier) s’ouvre : Recherchez le fichier « .ezcfg » 
dont vous avez besoin, puis double-cliquez dessus. 
 
Une fois le fichier .ezcfg chargé, les données remplissent l’écran et vous pouvez cliquer 
sur le bouton « Go » (Aller). 
 
Le fichier .ezcfg contient des commandes pour l’instrument. Après avoir cliqué sur le 
bouton « Go » (Aller), ProRAE Studio II envoie ces commandes à l’instrument. La réponse 
de l’instrument s’affiche sous la forme « **** ». ProRAE Studio II ne vérifie pas les 
commandes transmises de et vers l’instrument.  
 
Cette fonction permet à ProRAE Studio II de configurer l’instrument à l’aide de nouvelles 
commandes prédéfinies dans le fichier .ezcfg; si les nouvelles commandes sont prises en 
charge par l’instrument, elles ne sont pas forcément compatibles avec la version utilisée 
de ProRAE Studio II. 
 
Remarque : le fichier .ezcfg est fourni par RAE Systems lorsqu’une mise à jour est 
nécessaire. 
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16. Quitter ProRAE Studio II 
 
Une fois que vous avez terminé d’utiliser ProRAE Studio II et que vous souhaitez quitter 
le programme, assurez-vous d’avoir bien enregistré toutes les données que vous devez 
transférer ou conserver. Une fois cette vérification effectuée, cliquez sur le menu « File » 
(Fichier) et sélectionnez « Exit » (Quitter). 
 

 
 
ProRAE Studio II se ferme. Vous pouvez désormais débrancher l’instrument et le remettre 
en service. 
 

IMPORTANT! 
Avant d’utiliser l’instrument, vérifiez ses paramètres et réglages afin de vous assurer 
qu’aucune donnée incorrecte n’a été transférée alors que vous utilisiez ProRAE Studio II. 
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17. Assistance technique 
 
Pour communiquer avec l’équipe de l’assistance technique de RAE Systems : 
 
Du lundi au vendredi, de 7 h à 17 h (Heure du Pacifique - États-Unis) 
Téléphone (numéro vert) : +1 888-723-4800 
Téléphone : +1 408-952-8461 
Courriel : tech@raesystems.com 
 
Une assistance d’urgence en dehors des heures d’ouverture est disponible : 
 
+1 408-952-8200  sélectionnez l’option 9 
 
 

18. Coordonnées de RAE Systems  
 
RAE Systems 
Siège social mondial  
3775 N. First St. 
San Jose, CA 95134-1708 États-Unis 
Téléphone : +1 408.952.8200 
Fax : +1 408.952.8480 
  
Courriel :  customerserv@raesystems.com 
Site Web :  www.raesystems.com 
 
Assistance technique de RAE Systems 
Du lundi au vendredi, de 7 h à 17 h (Heure du Pacifique) 
Téléphone : +1.408.952.8461 
Courriel : tech@raesystems.com 
 
Une assistance d’urgence en dehors des heures d’ouverture est disponible : 
+1.408.952.8200  sélectionnez l’option 9 
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RAE Systems Europe ApS 
Kirstinehøj 23 A 
DK-2770 Kastrup 
Danemark 
Téléphone : +45 86 52 51 55 
Fax : +45 86 52 51 77 
orders@raeeurope.com 
sales@raeeurope.com 
service@raeeurope.com 
Site Web : www.raesystems.eu 
 
RAE Systems UK Ltd 
D5 Culham Innovation Centre 
Culham Science Centre 
Abingdon, Oxon OX14 3DB 
Royaume-Uni 
Téléphone : +44 1865408368 
Fax : +44 1235531119 
Téléphone mobile : +44 7841362693 
Courriel : raeuk@raeeurope.com 
 
RAE Systems France 
336, rue de la fée des eaux 
69390 Vernaison 
France 
Téléphone : +33 4 78 46 16 65 
Fax : +33 4 78 46 25 98 
Courriel : info-france@raeeurope.com 
Site Web : www.raesystems.fr 
 
RAE BeNeLux BV 
Rijndal 20 
2904 DC Capelle a/d IJssel 
Téléphone : +31 10 4426149 
Fax : +31 10 4426148 
Courriel : info@rae.nl 
Site Web : www.rae.nl 
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RAE Systems Spain, s.l. 
Av. Remolar, 31 
08820 El Prat de Llobregat 
Espagne 
Téléphone : +34 933 788 352 
Fax : +34 933 788 353 
Téléphone mobile : +34 687 491 106 
Courriel : mdelgado@raespain.com 
Site Web : www.raespain.com 
 

RAE Systems Middle East 
LOB 7, Ground Floor, Office 19 
Jebel Ali Free Zone 
Dubai, Émirats Arabes Unis 
Téléphone : +971.4.887.5562 
Fax : +971.4.887.5563 
 

RAE Systems (Hong Kong) Ltd. 
Units 1516-18, 15/F Delta House 
3 On Yiu Street, 
Shatin, N.T. 
Hong Kong 
Téléphone : +852.2669.0828 
Fax : +852.2669.0803 
Courriel : hksales@raesystems.com 
 
RAE Systems Japan 
403 Plaza Ochanomizu Bldg. 2-1 
Surugadai Kanda Chiyoda-Ku 
Tokyo, Japon 
Téléphone : 81-3-5283-3268 
Fax : 81-3-5283-3275 
Courriel : jpsales@raesystems.com 
 
RAE Systems Korea 
#1010, DaeMyungAnsVill First, 
Sang-Dong 412-2, Wonmi-Gu, Bucheon, 
Kyungki-Do, Corée 
Téléphone : 82-32-328-7123 
Fax : 82-32-328-7127 
Courriel : krsales@raesystems.com
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